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1 Objetivos

Con este documento se persigue iniciar al alumno en la aplicacién de simulacién Roboguide,
persiguiendo los siguientes objetivos:

1. Crear un espacio de trabajo
2. Definir un robot y su herramienta

3. Realizar movimientos con el robot simulando la accién sobre la consola de
programacidén (Teach pendant) y aprovechando utilidades propias de esta aplicacion.

4. Programar el robot, utilizando las dos herramientas basicas que existen para ello
5. Trabajar con registros de posicion utilizados como posturas de un robot.
6. Trabajar con registros de posicion utilizados como offset.

7. Realizar movimientos con el robot simulando la accién sobre la consola de
programacion (Teach pendant) y aprovechando utilidades propias de esta aplicacion.

2 Creaciony definicion de una célula de trabajo

En esta seccion se llevaran a cabo parte de los anteriormente citados objetivos 1y 2. En primer
lugar se creara una célula de trabajo, asociada al proyecto que a continuacién iniciaremos.
Durante su creacidn, se especificara el robot a utilizar, y su herramienta. Posteriormente, se
definiran las zonas o zonas fijas (fixtures) de que se compone la célula, y finalmente se
seleccionara el objeto o parte mdvil (parts) que sera manipulada. Basicamente existen dos
menus emergentes desde donde se accederan a la mayoria de las funcionalidades.

e Laprimera es Cell Browser, que es un explorador de proyecto que aparece por defecto
alaizquierda de la ventana. Puede ocultarse o mostrarse en View - Cell Browser.
e Lasegunda ventana es el Process Navigator y aparece al seleccionar View—>Navigator.

2.1 Creacion de la célula de trabajo

En Process Navigator (View—>Navigator), elegir Start New Cell, elegir un nombre para la célula
y dar a todas las opciones por defecto hasta finalizar.

Detalles a observar sobre el Zoom, desplazamiento y cambio del &ngulo de vista:
e (Girando la rueda central se hace zoom out y zoom in.
e Pulsando la rueda central y moviendo el ratén se desplaza el centro de la imagen

e Pulsando el botén derecho y moviendo el ratdn se cambia el dngulo de vista.



e También existen en la barra de menu una serie de botones para zoom, centrado y
cambio de la vista.

2.2 Desplazando la base del robot

2.3 Seleccion de la herramienta

A continuacién se muestran los pasos para establecer y configurar la herramienta, tanto en su
estado de abierto, como de cerrado

2.3.1 Estado abierto

1. Seleccionar Process Navigator - Edit End of Arm Tooling (EOAT)

2. Ennombre, escribir Garra. Pulsar el botén de la derecha donde aparece el icono de un
robot, y seleccionar la carpeta EOATs—>grippers.

3. Seleccionar 36005f-200.igs y pulsar Apply.
La garra seleccionada es demasiado grande, por lo que conviene reducir sus
dimensiones aplicando una escalado de 0.5 en X, Y, Z.

5. Para modificar la orientacién de la garra, cambiar el 4ngulo yaw W a 2702.



En esta situacidn el TCP se sitiia justamente en la mufieca. Sin embargo, deberia situarse en el

punto en que la garra suele asir la pieza. Esta posicion se encuentra 500mm desplazada de la

muileca, en la direccion z. Por tanto,

10.
11.

12.

en la pestaiia UTOOL, se indicara 500mm valor en el eje z, y 0 en los demas.
Al pulsar Apply, se observa como una esfera verde, indicativa del TCP, se desplaza dicha
cantidad.

Estado cerrado

En la ventana de Simulation, seleccionar la operacion de manipulacion, es decir
Function—->Material Handling-Clamp.

A continuacién, se abre la imagen CAD que corresponde a la garra en su posicién
cerrada. Para ello, se busca dicha imagen la carpeta grippers y se selecciona: 36005f-
200-3.igs (o tal vez 36005f200-4.igs si se desea una garra mas cerrada).

Pulsar Apply y cambiar entre estado abierto y cerrado.

Para no variar accidentalmente esta configuracidon se selecciona General->Lock All
Location Values.

Tras esto, pulsar OK para cerrar.

2.4 Actuando sobre las articulaciones del robot sin Teach Pendant

0Bk E World

R n...[X] |

= .jug Coord

JogFmn

2.5 Moviendo el robot con Teach Pendant

De igual forma que con el robot real, se puede utilizar la Teach pendant simulada para realizar
y visualizar movimientos del robot.



Para realizar cualquier movimiento o registrar (record) una posicion es preciso habilitar la
consola (ponerla a ON), y pulsar Shift.

Antes de pulsar Shift, pulsar COORD y seleccionar JOINT. A continuacidn, elevar la velocidad en
% hasta 100 (el botdn de abajo).

Pulsar Shift y X+ y ver cémo gira la base. De igual forma con las otras articulaciones, incluidas
las de la mufieca.

2.6 Definicion de las partes o zonas fijas (fixtures)

A continuacién, se estableceran las zonas fijas que actian como soporte de las piezas a
manipular, tanto para la zona de suministro como de dejada.

De igual forma que con las propiedades del robot puede comenzarse el proceso desde el Process
Navigator o el Cell Browser. Esto mismo sucedera con edicién de objetos o partes mdviles
(Parts) o las herramientas, que se veran posteriormente.



Pasos a seguir para la zona de suministro:

Process Navigator (Define the Cell) > Add a Fixture to the Cell

Box Primitive Model.

General>Asignar Name = "Pick Fixture"

Size in Z = 500. Color = azul palido

Mover la caja a la posicién (Location Properties) 1500, 0, 500, 345, 0, 0, o editar
directamente estos datos. Pulsar Apply

6. Bloquear los movimientos (Lock all location values)
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Una caja azul aparecera girada respecto al suelo. Se ha supuesto un giro para simular una rampa
por la que caera la pieza suministrada.

Repetir el proceso para la zona fija de dejada. Dar nombre "Place Fixture", Size in Z = 750, Color
=rojo palido, Location properties = 850, 1500, 750, 0, 0, 0.

2.7 Definicion del objeto a ser manipulado

Seguidamente, se selecciona y define el objeto a ser manipulado. En este caso serd una caja
importada de la libreria de objetos.

Pasos:

1. Seleccionar Process Navigator >Add a Part to the Cell2>Import from
Librarian>workpieces—>Box y asignar Caja como su nombre.
2. Disminuir la dimensién en X e Y, poniendo 0.5 en Scale X e Y.

Aparecera dicha caja en un soporte lejano que unicamente muestra las partes que pueden ser
seleccionadas.

2.8 Definicion de la forma en que la garra coge la pieza

Pasos a seguir:

1. Abrir la ventana de propiedades de la garra. Volver a deseleccionar General->Lock All
Location Values.

Ahora hay que indicar como debe ser la forma en que la garra cerrada coge a la pieza.

2. Seleccionar la pestaia Parts, y dentro de esta ventana, la forma disponible (Caja).

3. Pulsar Apply y habilitar "Edit Part Offset". Se vera la pieza cogida por la garra, aunque
en una posicion desplazada. Para situarla en su sitio, escribir
-60,-525,-120,0,0,0.

4. Al presionar Simulation-> Open y Close se visualizard el dibujo que corresponde a
dichos estados.



2.9 Asociar la forma manipulada con las zonas fijas

El objetivo es indicar en qué posicion debe quedar la forma al apoyar sobre la zona fija, asi como
establecer el tiempo durante el que sigue viéndose la forma sobre la zona fija al ser cogida por
la garra del robot. Hay que tener en cuenta que Roboguide se centra en el movimiento del robot,
no de las piezas en su entorno de trabajo.

Pasos:

1.

5.

Seleccionar la pieza fija de suministro. Para ello puede hacerse doble click sobre ella, o
bien abrir Cell Browser, y seleccionar Properties.

En la pestafia Parts, seleccionar Caja, y pulsar Apply. La caja aparecera sobre el plano
inclinado.

Habilitar Edit Part Offset. Editar en alguna de las posiciones un valor elevado (p.ej.
1000) para ver el resultado, pero finalmente dejar todos los cuadros de posicién a 0. En
cuanto a W, Py R, asignar 90, 0, 180. Estos valores (orientacidn respecto de los ejes X, Y
y Z respectivamente) determinan la orientacién con la que la herramienta (el robot)
cogera la pieza.

Pestafia Simulation - Allow Part to be picked para permitir que se recupere la pieza
desde esta zona fija. Indicar el valor de 2.0 que indica que tras coger la pieza de esta
posicion tardara 2 s en visualizar una nueva pieza en dicha posicién (simulando un
alimentador que ha dejado una pieza nueva).

Pestafia General - Lock all location values

Repetir el proceso con la posicién de dejada, pero cambiando l6gicamente la zona fija (ahora
serd Place Fixture), y habilitando en Simulations la opcidn "Allow part to be placed" en vez de
"Allow part to be picked".

Para guardar la célula, posiciones y programa, seleccionar File->Package cell (o alguna opcion
similar) para empaquetar todo el trabajo realizado.

3 Creacion de subprogramas para operar sobre el robot

Se parte de la célula creada en el apartado anterior.

3.1 Creacion de un programa TP



3.1.1
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Mover la garra a una posicion de reposo. Puede hacerse con la consola de programacion,
o bien desplazando/rotando la esfera verde.

Si no aparecen ejes cartesianos, seleccionar View—>Quick Bars—=>Jog Coordinates

En la ventana "Simulation Program Editor" pulsar Record. Esto grabara esta posicion
como posicion P[1], y ademas afiadira la linea de movimiento a dicha posicion.
Seleccionar movimiento de tipo J.

Secuencia de suministro.

Se realizaran las siguientes tareas: incluir la instruccion de coger pieza, llevar el robot a
la posicién donde ha de coger la pieza y finalmente situar el robot un poco por encima
para definir la posicién de aproximacidén. Para ello, seguir los siguientes pasos:

Pulsar nuevamente Record dos veces mas para que afiada dos nuevas posiciones que
luego se modificaran: la de cogida y la de aproximacion.

En la ventana "Simulation Program Editor", seleccionar Inst->Pickup(Caja, Pick Fixture,
Garra). Esto originara un conjunto de instrucciones que tomaran la caja de la pieza fija.
En el programa, seleccionar la linea anterior a la instruccion Pick.

Seleccionar Touchup To Pick/Place Point. En funcién de cémo se orient6 la forma en la
pieza fija, el robot calcula la posicién y orientacion con la que coger la pieza, aunque atin
no se mueve hacia ella. La orden Touchup modifica la posicién de la instruccién en la
que esta para que coincida con la posicién calculada. Para mover a dicha posicion, pulsar
MoveTo.

Ahora se trata de situar la garra un poco por encima de esta posicién de suministro.
Para ello, seleccionar View—>Quick Bars—>Jog Coordinates>Tool y empujar la
herramienta segun el eje z (hacia arriba). Situarnos en la segunda instruccién de
movimiento a P[1] para de esta forma poder modificarla. Pulsar Touchup.

Comprobar que se pueden alcanzar las distintas posiciones. Si no es asi, habilitar la
Teach Pendant, y comprobar (Tecla Posn) que las variables articulares no estan
proximas a -360 o 360.

Secuencia de dejada.

Seleccionar la tltima linea

Mover a una posicion alejada y pulsar Record (Movimiento ])

Cerrar la garra y llevarla cerca de la zona fija de dejada. Pulsar Record (])

Hacer doble click sobre la zona fija de dejada y seleccionar la pestafia Parts.
Seleccionar la forma Caja. En la lista desplegable seleccionar la garra del roboty MoveTo
Pulsar Record (L)

Seleccionar Inst—>Drop de la ventana del programa, y la forma elegida

Alejar la garra y pulsar Record.

Tras esto se puede ejecutar el programa.



3.1.3 Programar el cierre y apertura de garra
Seguidamente se indica la forma de programar la accién sobre la garra

1. Botén derecho en Cell Browser->Robot Controller>Programs—->Add Simulation
Program. Escribir Toma.

2. Seleccionar Inst>Pickup. Seleccionar Caja.

3. Seleccionar una espera de 0.5 s (Inst->Wait)

De esta forma se crea el programa de cierre de garra. Para el de apertura el método es analogo.

4. Boton derecho en Cell Browser>Robot Controller>Programs —>Add Simulation
Program. Escribir Deja.

5. Seleccionar Inst=>Drop. Seleccionar Caja.

6. Seleccionar una espera de 0.5 s.

En el apartado siguiente se mostrard como llamar a dichos subprogramas dentro de un
programa global.

3.2 Creacion de un subprograma con la consola de programacion

3.2.1 Enseiar la Secuencia de suministro
7.

10.

11.

3.2.2 Enseiar la Secuencia de Dejada

12.
13.

14.

15.



16.

17.
18.

4 Programa de apilado

A continuacidn, el alumno ha de programar al robot que realice una tarea de apilado. Se supone
que el suministro se realiza siempre en la misma posicién, la denominada posicién de
suministro. Sin embargo, el almacenamiento se lleva a cabo apilando un conjunto de tres piezas,
a partir de la llamada posicién de almacenamiento.

Durante la realizacion de este apartado, grabar asiduamente el proyecto con File->Save Cell.

4.1 Definicion de los registros de posicion

Para acceder a la ventana en que se definen los registros de posicion, pulsar el boton Data
(botdén debajo de F4) de la Teach Pendant. Si no aparece un listado de PR, seleccionarlo con
F1/TYPE. En esta nueva ventana, hay que tener en cuenta que tanto los movimientos como la
grabacion de los registros requieren de la activacion de la tecla Shift. Sin embargo, muchas otras
actuaciones no se llevaran a cabo si precisamente dicha tecla esta activada.

Llevar el robot a la posicién de suministro, tal como se indic6 el subapartado 3.1.2, es decir:

e Hacer doble click sobre la zona fija de suministro (entonces se eligié6 dejada) y
seleccionar la pestafia Parts.
e Seleccionar la forma Caja. En lalista desplegable seleccionar la garra del roboty MoveTo

A continuacién Registrar (record) la postura como PR[2:Aliment]. Pulsando F4 se tiene acceso
a las coordenadas cartesianas o en el espacio de las articulaciones (mediante [REPRE]). Con F4
Done se vuelve al ment anterior. Para escribir el nombre del registro de posicién (p.ej. Aliment),
basta pulsar Enter y escribir directamente el nombre a través del teclado del ordenador.

Registrar de igual forma la posicién de dejada original como PR[3:Dej_Orig].

Partiendo de alguna de estas posiciones, mover el robot con la consola de programacién a una
posicién elevada entre ambas zonas fijas. Seleccionar la primera linea de los registros de
posicién PR, y pulsar Shift+F3 (Record). Se nombrara PR[1:Reposo].

Con Move_To , mover a la posicion PR[2], de nuevo a PR[1], y posteriormente a PR[3] y PR[1],
para comprobar que todos los movimientos son factibles.

Estos tres son los registros de posicion APRENDIDOS.



El registro PR[4] no sera ensefiado, sino que se asignara en tiempo de ejecucion. Designarlo
Dejada. El registro PR[5] se utilizard como registro de offset. Entrando con F4, asignar z = 100
y 0 en las otras 5 componentes (no dejarlas simplemente con asteriscos). Asignar un nombre a
este registro, p.ej. OffsetZ. Si intentamos movernos a dicha posicién, dara error porque
realmente no se trata de una postura, sino un desplazamiento respecto a una postura o posicion.

4.2 Creacion de un programa en la consola de programacion

Se supone que en el subapartado 3.2.3 se crearon los subprogramas de abrir y cerrar garra.

4.2.1 Diseiio previo del programa.
Esta tarea habra de ser realizada antes de entrar en el laboratorio y habra de ser enviada por
correo al profesor

Disefiar e introducir un programa con la consola de programacién que realice la tarea de apilar
tres piezas prismaticas en la posicién de almacenamiento. Las piezas son suministradas de
forma consecutiva en la posicion de suministro.

La altura de la pieza es de 125 mm. La velocidad de aproximacién y alejamiento se establecera
en 200 mm/s.

Para abrir y cerrar la garra, hacer llamada a CALL Toma y CALL Deja.

4.2.2 Introduccion del programa en la consola de programacion
Si no se ha creado el programa principal, el botéon SELECT permite crear un programa vacio
listo para editarse.

Tener en cuenta que es posible pasar de la ventana de registros de posicion a la de edicién de
programa simplemente pulsando Data y Edit, segin corresponda.

Una vez dentro del programa, acceder a las opciones POINT para afiadir un movimiento o INST
para afadir cualquier otra instruccién (por ejemplo, una instruccién CALL de ejecucién de
subprograma Toma o Deja).

Téngase en cuenta que se esta trabajando con registros de posicién PR, y no con posiciones P.
Para cambiar entre las distintas opciones se pulsara Choice (por ejemplo para cambiar de P a
PR, o bien para afiadir la opcién de movimiento segin OFFSET).

En caso de necesitar incluir, copiar o suprimir una linea o bloque de lineas hay que acceder al
menu EDCMD.

Ya se puede ejecutar el programa desde el simulador. Si se ejecuta desde la consola, no se
producira el cierre o apertura de la garra.
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